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Chapter 1

Vic-2D Manual

1.1 Navigating the Online Help System
This document is also available in the Vic-2D software and can be accessed by selecting the
Help menu entry. This will open up a help window to view the documentation. The help viewer
provides a contents tree view that can be expanded and collapsed to navigate the sections of
this manual. Double-clicking on items in the content tree will display the corresponding page.
Furthermore, a keyword search is provided in the Index panel and a full-text search can be
accessed by clicking on the Search tab.

Context-sensitive help is available for many dialogs by pressing the F1 key while the dialog is
active. This will automatically display the corresponding section in the manual.

Vic-2D uses context menus that can be activated by right-clicking on many user
interface elements (lists, image views, plots etc.) to provide quick access to common
functions. Before searching the help, a right-click may reveal how to access the sought
for functionality.

1.2 Getting More Help
If you cannot find an answer to your question in this manual, please do not hesitate to contact
our technical support at support@correlatedsolutions.com. You can also find contact information
at our web site at www.correlatedsolutions.com.

We will be happy to assist with topics such as:

• Designing digital image correlation experiments
• Calibration
• Troubleshooting errors
• Interpreting test data
• Achieving optimal results
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1.3 Bug Reports and Feature Requests
If you encounter a bug in Vic-2D, please let us know about it. Send a short description of the
problem to support@correlatedsolutions.com along with any project or image files you think may
help us reproduce the bug.

Also, if you think Vic-2D can be improved by adding a particular feature you would find
helpful, let us know about it. We will try to incorporate your requests in our future updates of
the software.

mailto:support@correlatedsolutions.com


Chapter 2

Overview

The user interface of Vic-2D has many of the familiar control elements found in other applications.
The image below illustrates the user interface. The most commonly used functions can be accessed
by clicking on tool buttons on the Tool Bar. The windows, such as the AOI Editor and Plot
windows are grouped inside a Workspace. The List View on the left of the main window
provides a quick overview of image and data files.

Figure 2.1: Vic-2D Application Window
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2.1 File Menu
The File Menu provides the following functions:

• New - creates a new project
• Open - open an existing project
• Open recent - select from recently accessed projects
• Save - save the current project
• Save As... - save the current project under a new file name
• Mode - select a Vic-2D project type
• Install module licenses - use this menu entry to activate software modules you have

purchased
• Quit - quit Vic-2D

2.2 Edit Menu
The Edit Menu provides the following functions:

• Undo - undo the last editing operation in the reference image
• Redo - redo the last editing operation in the reference image
• AOI tools - each AOI tool is selectable from this menu.

2.3 Project Menu
The Project Menu provides the following functions:

• Speckle images- adds speckle images to the project for analysis
• Calibration images - adds calibration images to the project.
• Speckle image groups - add a group of speckle images with the same prefix
• Calibration image groups -add a group of calibration images with the same prefix
• Data files - adds pre-existing output data files to the project
• Analog data - adds analog data files from Vic-Snap
• Video clip - adds generated AVI files

2.4 Calibration Menu
The Calibration Menu provides the following functions:

• Calibrate scale - use a calibration image to create a pixel:mm scale calibration
• Distortion correction - use an analyzed distortion sequence to create a parametric

distortion correction
• Clear distortion - removes the current set distortion map
• More - set advanced parameters [i.e., aspect ratio]
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2.5 Data Menu
The Data Menu provides the following functions:

• Start analysis - shows the Run dialog to begin analysis
• Postprocessing tools - shows a submenu to choose from various postprocessing calcula-

tions
• Export - various options for exporting full data set or reductions

2.6 Plot Menu
The Plot Menu provides the following functions:

• New plot- adds a new plot window to the work space
• Inspector- allows choice of various data inspection tools

2.7 Window Menu
The Window Menu provides the following functions:

• Cascade - organizes all MDI windows in a cascade
• Tile - tiles all MDI windows

2.8 Help Menu
The Help Menu provides the following functions:

• User manual - show this manual.
• About - show version information.

2.9 Main Toolbar

Figure 2.2: The main toolbar.

The buttons on the main toolbar control commonly used Vic-2D functions. From left to
right:

File tools:

• New project
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• Open project
• Save project
• Add speckle images
• Add calibration images
• Calibrate stereo system
• Start analysis

Histogram control
Plotting tools:

• Zoom in/out
• Undo/redo

Postprocessing tools:

• Calculate strain
• Calculate velocity
• Time filter data
• Calculate in-plane rotation
• Apply a custom function
• Remove variables
• Remove rigid motion

The histogram control displays the gray level distribution for the currently displayed image.
The red bars on the histogram may be used to adjust the image display. Double-click on the
histogram to automatically adjust the balance, or drag the red bars to set the black and white
levels manually. Double click again to remove the balance adjustment.

The balance control is for display only and does not affect image analysis or stored images.

2.10 Animation Toolbar

Figure 2.3: Animation toolbar.

The buttons on the animation toolbar allow stepping through and animating image files or
plots. The controls, from left to right:

• Play - begins automatically stepping through images/plots.
• Stop - stops the animation.
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• Step Back / Step Forward - goes to previous or next image/plot.
• Loop - toggles between looping from last image to first, and bouncing from forward to

backward animation.
• Frame rate - selects the speed of the animation.

2.11 Other Functionality
In the right corner of the status bar at the bottom of the main window, the cursor position and
image grey value is displayed when the mouse is moved inside the reference image or a deformed
image. On the left side of the status bar, a short description of tool buttons and menu items is
displayed when the mouse moves over them.

In the list view on the left side of the main window, some functions can be activated by
right-clicking. Details can be found in the appropriate sections of this menu.





Chapter 3

The Start Page

The start page in Vic-2D gives convenient access to frequently-used tasks, recent projects, and
project type selection.

Figure 3.1: Vic-2D start page.

13



14 CHAPTER 3. THE START PAGE

3.1 Common Tasks
This section duplicates common tasks from the menu bar. Click to open a project, add speckle
or calibration images, or view this user manual.

3.2 Recent Files
This section contains a list of the most recently accessed projects. Click on an icon open the
project; mouse over an icon to see recent plots and images.



Chapter 4

Projects in Vic-2D

In Vic-2D, all the files and information associated with a test are stored in a project.
Initially, projects are blank. Before completing a Vic-2D analysis, the project must contain:

• One or more speckle images , including a reference image
• One or more areas of interest

Note: Adding speckle images to the project adds them by filename reference only; they are
not copied or moved on the disk.

When you run a Vic-2D analysis, the output files are stored on a disk and added (by reference)
to the project file. If the project file is not saved or if the data files are manually removed, they
will remain on the disk.

In addition to the items above, you can also choose to add auxiliary data references to the
project file:

• Generated video clips
• Analog data files from Vic-Snap

4.1 Notes
• In general, it is good practice to save project files often to avoid losing changes.

15





Chapter 5

The Project Toolbar

The project toolbar is displayed at the left side of the work area by default. It contains information
about image files, data, and calibration for the current project.

5.1 The Images Tab

Figure 5.1: Project toolbar files tab.

This tab shows all speckle and calibration images associated with the project.
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To add speckle images, select Images... Speckle images from the menu bar, or click the
speckle images icon on the main toolbar. The small red arrow indicates the reference image; to
set an image as the reference, right click and click Set as reference.

To add calibration images, select Images... Calibration images from the menu bar, or click
the calibration images icon on the main toolbar.

To remove an image or series of images, select them, right click, and click Remove or Remove
selected.

5.2 The Data Tab

Figure 5.2: Project toolbar data tab.

The Data tab lists all output data, analog data, and video files associated with the project.
All generated output files are added to the Current data list. Output files not associated

with current speckle images are added to Other data. Double-click on a data file to view a plot.
Analog data from Vic-Snap is listed under Analog data. To add an analog data file, select

File... Add Files... Add Data Files from the main menu. To view a spreadsheet of the data,
double-click the filename.

Generated video files from 2D animations are added to the Video files list. Double-click on a
video to display it in an external viewer.
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Figure 5.3: Analog data spreadsheet.

5.3 The Calibration Tab

Figure 5.4: Project toolbar calibration tab.

This tab is a static display of the current calibration information for the project. This will
consist of a calibration scale; a unit; and the camera’s aspect ratio.





Chapter 6

Speckle Images

In Vic-2D, speckle images are image or set of images taken of a specimen as it undergoes load or
motion. You may add one or multiple speckle images by selecting the Speckle images entry from
the Project menu, or by clicking the icon on the main tool bar.

If more than 300-400 images are to be added, select Project... Speckle image groups to add
sets of images from a specified folder. Select a folder to see a checklist of image prefix groups;
select one or more to add as speckle images. (Trying to add too many images directly through
the normal Speckle images dialog may result in an error due to operating system limitations.)

After adding speckle images to the project, they will be displayed in the workspace and listed
in the Images tab of the project bar as shown in the figure below.

6.1 Viewing Images
Deformed images can be displayed in the workspace by double-clicking on an entry in the image
list view. Alternatively, clicking the right mouse button on an entry of the list view will show a
popup menu providing different options, one of which is View.

When viewing deformed images, you can use the zoom in/zoom out entries in the Edit menu
or the corresponding tool buttons to change the scale of the displayed image.

6.2 Animating Images
To animate speckle images, display an image and then use the controls on the Animation Toolbar
to animate the sequence.

Removing Images
Speckle images can be removed by selecting one or multiple images in the list view, and

right-clicking on your selection. Select Remove or Remove selected to remove images from the
list.
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Figure 6.1: Project image panel showing speckle images.
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Figure 6.2: Calibration image list in project panel.





Chapter 7

The Reference Image

The term Reference Image is used in this manual to describe the image of the specimen taken
while no load was applied. All displacement analyses in Vic-2D are with respect to this reference
image, i.e., the displacements are obtained in a Lagrangian coordinate system.

To select a reference image, right-click on it in the Speckle images list, and select Set as
reference.

Figure 7.1: Speckle image list right-click menu.

After the reference image has been selected, it will be indicated with a red arrow in the
images list.

When the reference image is displayed, the Aoi tool buttons become active.
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Figure 7.2: Reference image indicator

Figure 7.3: Aoi tool box.

7.1 Selecting an Area-of-Interest
Vic-2D supports the following types of AOIs:

• Rectangle: Points are contained in a rectangular area.
• Polygon: Points are contained in an arbitrary polygon.
• Circle: Automatically creates a roughly circular polygon.

To specify a particular type of AOI, select the corresponding entry in the Edit menu or the
appropriate button on the tool bar. The selected AOI type will be indicated by the mouse cursor.

After selecting the AOI type, move the cursor to the desired position in the reference window
and click the left mouse button. You can now move the mouse to the next position, e.g. the
end of the line or the second corner of the rectangle. Clicking the left mouse button again
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will complete the AOI selection for all AOI types except polygons. For polygon selection, a
double-click is used to specify the last point of the polygon.

Figure 7.4: Selecting an area-of-interest.

Editing AOIs
To edit an existing AOI, select the Pan/Select tool. Mouse over any of the white nodes in

your AOI; the mouse cursor changes to indicate node movement. Click and drag to move. You
can delete a node by clicking the icon, then clicking the desired node.

If the merge polygons icon ( ) is selected, any overlapping polygons will be merged with
each other. If the icon is not selected, overlapping AOIs will remain separate.
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7.2 Cutouts
For rectangular and polygon AOIs, the scissors tool can be used to cut areas from the AOI. This
feature is most commonly used if the specimen has cracks, holes, or other areas where correlation
is impossible.

To cut an area from an AOI, click the scissors button on the tool bar or select Edit... Cut
region. The selection of the area to be cut works like selecting a polygon AOI, i.e., corner points
of a polygon can be added by single-clicking the left mouse button, and the last point is specified
by a double-click. Once the cut is complete, new nodes are added to your AOI; these may be
moved like other nodes.

7.3 Choosing the Subset and Step Size
The subset and step size can be selected after an area of interest is created. Both are adjusted
using the spin boxes in the AOI Toolbar.

Figure 7.5: Subset and step size control.

The subset size controls the area of the image that is used to track the displacement between
images. The subset size has to be large enough to ensure that there is a sufficiently distinctive
pattern contained in the area used for correlation. If you change the subset size, you will see the
current size illustrated by a grid briefly displayed on the AOI. To have Vic-2D suggest a subset
size, click the icon:

Vic-2D will choose a subset size which is calculated to give an optimal match confidence of
0.01 pixel for a given assumed noise level. The default of 8 works well for most cameras. To
accept the suggested size, click Ok; to return without making a change, click Cancel. The step
size controls the spacing of the points that are analyzed during correlation. If a step size of 1 is
chosen, a correlation analysis is performed at every pixel inside the area-of-interest. A step size
of 2 means that a correlation will be carried out at every other pixel in both the horizontal and
vertical direction, etc. Note that analysis time varies inversely with the square of the step size;
i.e., a step size of 1 takes 25 times longer to analyze than a step size of 5.

To cause subset and step size changes to apply to every AOI, check the Apply to all box. If
this box is cleared, subsets and steps can vary between AOIs.

7.4 Placing start points
In some situations, start points may be need for the correlation. To place a start point, click the
icon. The Initial Guess Selection page has more information about selecting end editing start

points.
To remove a start point, click the icon, then click the start point.
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Figure 7.6: Subset size suggestion dialog.
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• Use the scroll wheel to adjust the size of the image.
• When using multiple AOIs for one image, click on an AOI with the pan/select

tool to activate it.
• During AOI selection, the image can be scrolled by moving the mouse outside

the reference image window. This will cause the image to auto scroll if the
image does not fit on the display.

• You can use the Undo/Redo buttons to undo AOI selection and other operations.
The Undo/Redo buttons in the Edit menu will indicate what changes can be
undone/redone.



Chapter 8

Calibration Images

Calibration images can be added by selecting the Calibration images entry from the Images
menu, or by clicking the icon on the main tool bar.

After adding calibration images to the project, they will be listed in the Images tab of the
project bar, as illustrated below.

Figure 8.1: Project image panel showing calibration images.
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8.1 Viewing Images
Calibration images can be displayed in the workspace by double-clicking on an entry in the list
view on the left. Alternatively, clicking the right mouse button on an entry of the list view will
show a popup menu providing different options, one of which is View.

Figure 8.2: Calibration image list right-click menu.

When viewing calibration images, you can use the zoom in/zoom out entries in the Edit
menu or the corresponding tool buttons to change the scale of the displayed image.

8.2 Removing Calibration Images
Calibration images can be removed by selecting one or multiple images in the list view, and
right-clicking on your selection. Select Remove or Remove selected to remove images from the
list.



Chapter 9

Calibration

The scale calibration dialog may be used to establish a physical scale for your measurements.

Figure 9.1: Scale calibration with manual points.

There are three tools for scale calibration.

• Manually select: this tool is used to select two manually identified points.
• Snap to cross: this tool is used to select two quadrant markers.
• Snap to circle: this tool is used to select two elliptical markers.

The known distance between the two points is entered in the Point distance field. Once a
calibration is present, correlation results will be presented as metric locations and displacements.
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Initial Guess Selection

In Vic-2D, initial guesses will be needed very rarely. Some instances where they may still be
necessary include:

• Large rotations between successive images
• Very fine or indistinct speckle patterns
• Poor calibration.

In the absence of these conditions, you can generally run the correlation immediately after
selecting an AOI. If the correlation fails or runs very slowly, an initial guess may be needed.

Even if an initial guess is not required, placing a start point in an appropriate location
(see below) can make the analysis faster. This is the case even if the start point
location is not pre-computed for all images before correlation analysis.

10.1 Placing Start Points

A start point may be placed by clicking the icon in the Mask tools box from the AOI Editor.
Once a start point is placed, Vic-2D will start looking for initial guesses in the background. If
initial guesses are not automatically found, manual editing may be required.
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Generally, it is best to place a start point in the area of the image that undergoes
the least amount of motion during the test. For instance, if a specimen is tested in
a tensile frame, the start point should be placed as close to the stationary grip as
possible. Placing the seed point this way will help ensure fully automatic correlation.
If a specimen is expected to fail or crack, it may help to put start points on either
side of the specimen so that once failure occurs there will still be a start point on
both surfaces.
For very large transformations or rotations, it can be very helpful to place fiducial
marks on the surface. This can be integrated into a printed pattern or simply drawn
on the surface with a marker. These marks may be located much more easily than
the random pattern especially if, i.e., one image is rotated 180 degrees from the other.

10.2 Editing Initial Guesses
The initial guess dialog can be accessed by double clicking on the icon in the AOI editor, or
right-clicking and selecting Edit guesses. The Initial Guess Editor will appear.

Figure 10.1: Initial guess editor.

The two windows on the left show the reference image on the left and the selected deformed
image on the right. The small windows at the upper right show the zoomed-in guess for the
same two images. The list at the lower left shows all the deformed images; where a guess is
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already present, the marker will be green. A yellow marker indicates a guess exists for only one
image of that pair, and a red marker means no guess exists.

To add a guess, drag the corresponding square from the stereo or deformed image until it
is in the same spot as the reference image (at left). To make control easier, you can zoom in
and out of the image with the mouse wheel, or by clicking the icon and drawing a box; or
click the icon to zoom into the current guess area. A histogram control is provided for the
reference and deformed images. Adjust the red bars to control image balance; this can be useful
for finding detail in very dark images. Double click the histogram to automatically set/reset the
limits.

Below, the deformed image guess has been dragged to the approximate correct location:

To check the guess, click the icon, or just right-click in the desired image:
If the correct match is found, you will be prompted to right-click again to accept it. If the

match is not found, you can check the location and try again; but where severe scaling or shear
is present, you may need to add more details by adding more points or setting scaling/shear
with the control nodes.

10.3 Initial Guesses from Corresponding Points
Initial guesses, including deformation components, can be set using corresponding control points.

Control points may be added to the reference image by clicking the icon and then clicking
on an easily identifiable image feature, e.g. the center of a speckle. Up to three points can be
added:

The control point locations are automatically shown in the deformed views based on the
current guess parameters. These points may be dragged to the correct location by clicking on
them and then dragging the mouse while keeping the button pressed. Note that Vic-2D will not
allow points that are too close together, or too close to colinear. Control points may be deleted
by first clicking and then clicking on the point to remove.

While you are dragging, you will see that the small view to the upper right changes to reflect
the transformed subset. When the match is good, the two views will look very similar:

You may also drag the control points on the red rectangle to adjust the transform more
directly. The upper left control point affects rotation; the left and bottom points control X and
Y scaling; and the upper right and lower right points control shearing.
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Figure 10.2: Approximate guess location.
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Figure 10.3: Initial guess found.
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Figure 10.4: Setting control points.
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Figure 10.5: Red rectangle control points.

Figure 10.6: Comparison view of reference and resampled deformed subset.
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Running the Correlation

To run the displacement analysis, select the Run Correlation entry from the Data menu, or press

the button on the tool bar.

11.1 The File Tab
This tab displays the following options:

11.2 Selecting Images
The deformed images to use for correlation analysis can be selected from the list box on the
dialog. Selected images are indicated by a check mark. Above the list box, buttons are available
to select/deselect all image files contained in the list box. To select 1 data file from every 2, 5,
10, or n , right-click in the file list and choose the desired option.

If no images are selected, only the reference image is analyzed.

11.3 Backup copies
When this option is checked, Vic-2D will make backup copies of existing output files by replacing
their file extension with bak.

11.4 Output directory
The directory in which the output files are stored can be selected by clicking the folder icon.

11.5 The Options Tab
This tab displays the following options:
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Figure 11.1: Analysis dialog file tab

11.6 Subset weights
This option controls the way pixels within the subset are weighted. With Uniform weights,
each pixel within the subset is considered equally. Selecting Gaussian weights causes the subset
matching to be center-weighted. Gaussian weights provide the best combination of spatial
resolution and displacement resolution.

11.7 Interpolation
To achieve sub-pixel accuracy, the correlation algorithms use gray value interpolation, representing
a field of discrete gray levels as a continuous spline. Either 4-, 6-, or 8-tap splines may be
selected here.
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Figure 11.2: Analysis dialog options tab

Generally, more accurate displacement information can be obtained with higher-order splines.
Lower-order splines offer faster correlation at the expense of some accuracy.

11.8 Criterion

There are three correlation-criteria to choose from:

• Squared differences: Affected by any lighting changes; not generally recommended.
• Normalized squared differences: Unaffected by scale in lighting (i.e., deformed subset is

50% brighter than reference.) This is the default and usually offers the best combination
of flexibility and results.

• Zero-normalized squared differences: Unaffected by both offset and scale in lighting (i.e.,
deformed subset is 10% brighter plus 10 gray levels.) This may be necessary in special
situations. However, it may also fail to converge (produce a result) in more cases than the
NSSD option.
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11.9 Low-pass filter images
The low-pass filter removes some high-frequency information from the input images. This can
reduce aliasing effects in images where the speckle pattern is overly fine and cannot be well
represented in the image. (These aliasing effects are often visible as a moire-type pattern in the
output data.)

11.10 Incremental correlation
With incremental correlation, each image is compared to the previous image rather than the
reference image. This can be useful in cases of pattern breakdown or extremely high strains
(>100%). This comes at the expense of an increase in noise for later images, because the noise
continues to add over each successive correlation.

11.11 Fill boundary
Checking this option will cause Vic-2D to interpolate subset gradients to fill displacement data
out to the very edge of the AOI.

11.11.1 Exhaustive Search
Enabling this option will cause Vic-2D to repeat a coarse search for matches after each time
the correlation fails. This may result in more data recovery at the expense of vastly increased
processing time.

11.12 Processor Optimizations
This option controls the number of processors/cores Vic-2D uses for analysis. In most cases this
will be correctly determined automatically by Vic-2D.

11.13 The Thresholding Tab
This tab provides options for removing any data that is bad or suspect while maximizing the
amount of retained data. Four thresholding options are available. For a typical test, the default
values will work very well, but when conditions are unusual or substandard (blur; debris; poor
lighting; etc), some adjustment may be required.

11.14 Consistency threshold
After Vic-2D analyzes the seed point, the analysis is propagated to each of its four neighbors,
and so on. Each point is fed with a prediction of its approximate match. After the match is
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Figure 11.3: Analysis dialog thresholding tab

made, a back-prediction is calculated. If the back-prediction does not closely match the actual
location of the prior neighbor, this threshold will remove the data.

11.15 Confidence margin
For each match, Vic-2D calculates a statistical confidence region, in pixels, using the covariance
matrix of the correlation equation. If the confidence region exceeds this threshold, the data will
be removed.

11.16 Matchability threshold
This option automatically removes subsets that show a very low contrast, i.e, subsets that don’t
contain very much information. Increase this value to remove more data; reduce to retain more
data, i.e., if lighting conditions were poor.

11.17 The Post-Processing Tab
The tab on the dialog displays the following options:
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Figure 11.4: Analysis dialog post-processing tab

11.18 Strain Computation
Checking this option performs a strain computation as each image is processed; results can be
viewed in the preview.

11.19 Correlation Results
After you begin the correlation, the following window appears.

The window contains an overview of correlation progress and results.
File - the progress and total number of files to analyze.
Points - the number of data points calculated for the image.
Error - this is the average confidence margin for the data set; lower numbers indicate a

better quality match.
Time - The amount of time spent on correlation analysis in seconds.
Progress bar - indicates the progress of each individual file as it is correlated.
This window also contains a preview of the output data. This data may be viewed and

manipulated as with a standard plot.
When the analysis is complete, you may click View Report to see a summary of the above

data.
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Figure 11.5: Analysis progress during correlation.
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For more information on interpreting correlation results and troubleshooting errors, please
contact Technical Support.
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Postprocessing tools

Once the initial position and displacement fields are calculated, several tools are available for
processing the data.

• Calculate strain - calculate surface strain tensors
• Remove rigid motion - removes overall object motion, leaving only deformation
• Apply function - apply arbitrary user-defined functions to create new variables
• Calculate velocity - uses time information to calculate velocity and strain rate
• Calculate in-plane rotation - calculates local surface rotation
• Smooth - smooths data over a user-specified diameter
• Delete variables - remove variables created with other postprocessing tools
• Apply math operation - applies simple math operations to discrete variables

12.1 Strain Calculation
To calculate strain for one or more data sets, select Data. . . Postprocessing options. . . Calculate
strain from the main menu. This will show the strain computation dialog as illustrated in Fig. 12.1.
Note that strains may also be computed during the correlation analysis, see Section 11.18 for
details.

12.1.1 Selecting Data Files for Processing
The available data files are displayed in the Data Files list box. To select which files to
process, click on the data file you want to select/deselect. This will toggle the check mark
indicating whether the file is selected or not. For convenience, the buttons labeled All and None
select/deselect all files, while Invert reverses your selection.

12.1.2 Preview
To view the effects of the calculation for a single data file, highlight the file and click the Preview
button. You may view the plot in 2D or 3D (in Vic-3D) as with a standard data plot.
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Figure 12.1: Strain dialog.

12.1.3 Compute Principal Strains
Check this box to add principal strains and principal strain angle to the calculated output data.

12.1.4 Overwrite Variables
Check this option to overwrite any existing strain calculations. If this box is clear, more data
fields will be added to the output data set each time strain is calculated.

12.1.5 Compute Tresca/von Mises strain
Select these options to compute the Tresca/von Mises strain criterion along with the strain
tensor calculation.
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12.1.6 Filter size/type
Calculated strains are always smoothed using a local filter. The Filter box allows selection of a
smoothing method. The decay filter is a 90% center-weighted Gaussian filter and works best for
most situations; the box filter is a simple unweighted averaging filter.

The Filter size box controls the size of the smoothing window. Since the filter size is given
in terms of data points rather than pixels, the physical size of the window on the object also
depends on the step size used during correlation analysis.

12.1.7 Raw Gradients
This option can be used to output the components of the deformation gradient tensor F. Note
that the deformation gradient tensor is computed in the local tangential plane of the surface,
and the x-direction is taken as the projection of the global x-coordinate onto this plane.

12.1.8 Tensor Type
Select the desired strain tensor. The default is Lagrangian finite strain. Note that in the case of
Vic-3D, strains are computed in the local tangential plane of the surface, and the x-direction is
taken as the projection of the global x-coordinate onto this plane. All strain tensors are derived
from the deformation gradient tensor F. Some of the definitions below use the Cauchy-Green
deformation tensor

C = FT · F

which is computed from the deformation gradient tensor F.

Lagrange
This is the default strain tensor and is given by

E = 1
2 (C− I)

Hencky
The Hencky strain, also called logarithmic or true strain, is given by

EH = 1
2 ln (C)

Euler-Almansi
The Euler-Almansi tensor is given by

e = 1
2
(
I− F−T · F−1

)
Logarithmic Euler-Almansi

The logarithmic Euler-Almansi strain is computed according to

el = 1
2 ln

(
F · FT

)
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Engineering
In order to avoid non-sensical strains due to rigid body rotations, the engineering strain
is not computed directly from the derivatives of the displacement, i.e., εx 6= dU/dX. To
access the plain derivatives, see Section 12.1.7 above. To make the strains insensitive to
arbitrary rigid-body motion, the engineering strains are computed from the Lagrange strain
tensor in the following manner:

εx =
√

(1 + 2Exx)− 1

εy =
√

(1 + 2Eyy)− 1

εxy = sin−1
(

2Exy√
(1+2Exx)(1+2Eyy)

)
Biot

The Biot strain tensor is given by
EB = C1/2

12.2 Removing Rigid Motion
This tool is used to remove rigid-body displacement from deformed images, leaving only defor-
mation components of displacement.

Once the displacement fields have been calculated from the speckle images, this tool can be
started by selecting Data... Remove displacements.

12.2.1 Data File Selection
The available data files are displayed in the list box. To select which files to process, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files; the
Invert button inverts the selection.

12.2.2 Processing Method
To remove all rigid body displacement, select Use average transformation. This will calculate
the average transformation for each image, and invert it to obtain an image with an average
displacement/rotation of 0. Only object deformation will be reflected in the transformed U, V,
and W displacements. This is useful for visualizing displacement fields in tests where deformation
is obscured by larger, rigid-body motions.

To keep a single point stationary, select Keep 1 point fixed and click the desired point in the
image. Only points within the data set (highlighted in blue) may be selected. With this method,
the selected point will become stationary, with all other displacements remaining relative to this
point. Any initial rotation will still be present after the operation.

To keep three points stationary, select Keep 3 points fixed; then, click three desired points in
the image to define the fixed points. With this method, all displacements and rotations will be
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Figure 12.2: Rigid motion removal dialog.

relative to the three selected points, which will become stationary. The point- and three-point
displacement options are useful for, i.e., determining deformation of a test subject relative to
fixed mounting points or standoffs.

If the three points you select are in three different AOI’s, you will be given the option to use
the entire AOI for the operation. This will be useful if, for example, you have small AOIs on top
of three separate fixed posts of a test fixture.

Click Compute to proceed with the computation.
Strain calculation
Note that these transforms will not affect calculated strain, nor are they necessary in

order to correctly calculate strain; the strain algorithm is, by nature, insensitive to rigid-body
displacements.

12.3 Applying Functions to Data
Vic-2D and Vic-3D support the generation of new variables based on equations applied to the
data. This feature may be used, for instance, to compute engineering strains from Lagrange
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strains, to compute stresses from strains or to compute thinning of a strained specimen of known
thickness based on the Poisson’s effect or volume conservation during plastic deformation.

Functions may be created, modified, and applied to data by selecting Data. . . Postprocessing
options. . . Apply function from the main menu.

Figure 12.3: Apply function dialog.

A previously defined function may be selected from the Function pull-down menu in the
upper left corner of the dialog. Each function may have one or more constants that are used in
its equations. When a function is selected, the corresponding constants are displayed next to
their current values. Some constants may contain pre-defined options for the value. Selecting
any of the options in the value combo-box will set the constant to that value.

12.3.1 Creating and Editing Functions and Constants
New functions and constants can be created and existing ones can be edited. Click on the
Edit. . . button to open up the Edit Functions dialog.

All available functions and constants are listed. Constants local to a function and the outputs
of a function are listed underneath the function they belong to.

The four buttons underneath the list allow for the creation, editing and deletion of functions
or constants. Each of the buttons are as follows:
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Figure 12.4: Edit functions dialog.

• Opens the wizard to create a new function.
• Opens the wizard to create a new constant.
• Opens a wizard to edit the selected function or constant. If an output is selected it

opens the function wizard to the edit outputs page.
• Deletes the selected function or constant. If an output is selected it deletes the function

it belongs to.

Double-clicking on any item in the list will open the respective wizard for editing.

12.3.2 Selecting Data Files for Processing
The available data files are displayed in the Data Files list box. Files to be processed can be
selected in the list at the top left by checking or unchecking. There all also buttons to select and
deselect all files and to invert the current selection.

12.3.3 Preview
The effects of the calculation on a single data file may be previewed by highlighting the file and
clicking the Preview button. You may view the plot in 2D or 3D as with a standard data plot.

12.3.4 The Function Wizard
Functions and their output variables can be defined and edited in the function wizard. The
wizard is a multi-page dialog that allows the user to enter all information required to define a
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function with one or more output variables.

12.3.4.1 Function Information

The first page of the function wizard is for entering a brief description of the function and the
scope in which the function is stored. The Global scope option stores the function in the program
settings where it can be used by any project. The Project stores the function in the project
itself. If the project option is selected, then the function and it’s local constants are stored in
the current project and is only accessible by the current project.

Figure 12.5: Function wizard information page.

12.3.4.2 Define Equations

The next page is where the actual equations are entered. There can be multiple equations and
they are separated by a new line; each should be in the form (variable)=(function definition).
Double click on a variable at left to insert it at the cursor.

After you enter your equations and click Finish, any errors will be announced and corrections
will be required before proceeding. For details on the equation syntax and built-in math functions,
please refer to Section 12.3.6.
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Figure 12.6: Function wizard equation page.

12.3.4.3 Define Output Variables

Every function must have at least one output variable. The output variable is the information
that is stored in the data files of the project. To add one, simply click Add an output. . . There
are two things to be entered for each output. The first is the actual variable itself as used in
equations. The second is a brief description of the variable - this will be displayed in plot context
menus. The ‘X’ icon is the delete button. Clicking it will delete the associated output.

12.3.5 The Constant Wizard
Constants for use along with predefined values can be created and edited in the function wizard.

12.3.5.1 Constant Information

The label defines what is to identify a given constant in an equation. The scope defines whether
or not the constant is accessible to all functions (Global) or if it is only accessible to a specific
function. The description is used to note the purpose of the constant.

12.3.5.2 Define Options

Defining options is not necessary but it can be helpful; for instance, a preselected group of
material property constants, as in the example below. There are two values for each option: a
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Figure 12.7: Function wizard outputs page.

description and a value.

12.3.6 Equation Format, Operators and Built-in Functions
The following table lists the functions that can be used in equations in Vic-2D and Vic-3D and
the number of arguments they require.

Function name Argument count Explanation

sin 1 sine function
cos 1 cosine function
tan 1 tangens function
asin 1 arcus sine function
acos 1 arcus cosine function
atan 1 arcus tangens function
sinh 1 hyperbolic sine function
cosh 1 hyperbolic cosine
tanh 1 hyperbolic tangens function
asinh 1 hyperbolic arcus sine function
acosh 1 hyperbolic arcus cosine function
atanh 1 hyperbolic arcus tangens function
log2 1 logarithm to the base 2
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Function name Argument count Explanation

log10 1 logarithm to the base 10
log 1 logarithm to the base 10
ln 1 natural logarithm to base e (2.71828...)
exp 1 e raised to the power of x
sqrt 1 square root of a value
sign 1 sign function -1 if x<0; 1 if x>0
rint 1 round to nearest integer
abs 1 absolute value
min var. min of all arguments
max var. max of all arguments
sum var. sum of all arguments
avg var. mean value of all arguments

The table below lists the binary operators available in Vic-2D and Vic-3D in order of priority
(higher values mean higher priority).

Operator Meaning Priority

and logical and 1
or logical or 1
xor logical xor 1
<= less or equal 2
>= greater or equal 2
!= not equal 2
== equal 2
> greater than 2
< less than 2
+ addition 3
- subtraction 3
* multiplication 4
/ division 4
ˆ raise x to the power of y 5

12.4 Calculating Velocity

Vic-2D and Vic-3D can calculate rates for displacement and strain, using either a specified time
interval or time retrieved from a .CSV log file.

Once the displacement fields have been calculated from the speckle images, velocities may
be calculated by selecting the Calculate Velocity entry on the Data menu. (If strain rates are
desired, strain should be calculated before opening the Calculate Velocity dialog.) This will
display the dialog shown in Fig. 12.10.
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Figure 12.8: Constant wizard information page.

Figure 12.9: Constant wizard options page.
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Figure 12.10: Velocity dialog.

12.4.1 Data File Selection

The available data files are displayed in the list box. To select which files to process, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files; the
Invert button inverts the selection.

12.4.2 Velocity Calculation

If a Vic-Snap .CSV log file exists for the project, you may select “Time From File” from the
dropdown and select the file, if necessary. Otherwise, select “Constant Time Step” and enter the
known time increment, or select “Constant Frame Rate” to enter a known frame rate, e.g., for
data from a high-speed camera.

Click Start to begin; the progress bar will indicate completion. For each strain and displace-
ment variable in the dataset, a derivative in time will be added and can be viewed as a contour
overlay.



64 CHAPTER 12. POSTPROCESSING TOOLS

12.5 Rotation Calculation
To calculate local in-plane rotation for a set of data, select Data. . . Postprocessing options. . .
Calculate in-plane rotation from the main menu. This displays the dialog illustrated in Fig. 12.11.

This function computes the in-plane rotation around the local surface normal. To
compute rigid-body rotation angles for the entire data set or selected areas (Vic-3D
only), see Section 14.9.1.

Figure 12.11: Rotation computation dialog.

12.5.1 Selecting Data Files for Processing
The available data files are displayed in the Data Files list box. The files that will be processed
are indicated with a check mark on the left. Selections can be made by clicking on the check
boxes or by selecting one or multiple entries and pressing Space or Enter. The context menu
provides further options for selecting a subset of data files. For convenience, the buttons labeled
All and None select/deselect all files, while Invert reverses the current selection.
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12.5.2 Filter Size
The Filter size box controls the size of the window over which the rotation is computed. Note
that a Gaussian weight function is applied to the window. Since the filter size is given in terms
of data points rather than pixels, the physical size of the window on the object also depends on
the step size used during correlation analysis.

12.5.3 Overwrite Variables
This box can be checked to overwrite any existing rotation variables from a previous computation.
If this box is not checked, more data fields will be added to the output data set each time
rotation is calculated.

12.5.4 Preview
To view the effects of the calculation for a single data file, highlight the file and click the Preview
button. Note that the context menu of the plot can be used to switch between 2D and 3D
plotting modes.

12.6 Smoothing Data
A smoothing filter may be applied to one or more data files by selecting Data. . . Postprocessing
options. . . Smooth variable from the main menu.

12.6.1 Selecting Data Files for Processing
The available data files are displayed in the Data Files list box. To select which files to
process, click on the data file you want to select/deselect. This will toggle the check mark
indicating whether the file is selected or not. For convenience, the buttons labeled All and None
select/deselect all files, while Invert reverses your selection.

12.6.2 Preview
The effects of the calculation for a single data file may be displayed by highlighting the file and
clicking the Preview button. The resulting plot may be viewed in 2D or 3D (for Vic-3D) as with
a standard data plot.

12.6.3 Filter Size and Type
Data is smoothed using a local filter. The Method box allows selection of a smoothing method.
The decay filter is a 90% center-weighted Gaussian filter and works best for most situations.
The box filter is a simple unweighted averaging filter.

The Filter size box controls the size of the smoothing window. Since the filter size is given
in terms of data points rather than pixels, the physical size of the window on the object also
depends on the step size used during correlation analysis.
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Figure 12.12: Smoothing dialog.

By default, 3D plots display deformed data - the sum of each point’s X,Y,Z location
and its U,V,W displacement. Because of this, creating a smooth plot of 3D data like
the one above requires smoothing both Z and W.

12.7 Deleting Variables
User-generated variables can be deleted from data files.

! Use this functionality with caution. Once removed, variables cannot be restored other
than by reprocessing.

To remove variables from data files, select Data. . . Postprocessing tools. . . Delete variables
from the main menu.
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Figure 12.13: Delete variables dialog.

12.7.1 Selecting Data Files for Processing
Clicking Select files will bring up a standard file selection dialog, allowing the choice of some
or all files to be processed.

12.7.2 Selecting Variables
The available variables are listed in the list box on the right of the dialog. Checking the box
next to a variable will cause it to be deleted.

Only user-generated variables such as strain, velocity, etc. may be deleted. Displace-
ment, position, etc., may not be removed.

12.8 Time Filter
Time filters can be used to filter the full-field data along the time axis. Currently, filters for
removing outliers and for smoothing are provided. The time filter dialog provides the ability
to select multiple filters to create a filter chain. This can be used to, e.g., remove outliers and
smooth data in a single pass. The time filter dialog is shown below.

To apply time filters to a data sequence, select Data. . . Postprocessing options. . . Time
filter from the main menu.
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Placing an inspector point prior to opening the dialog will allow visualization of the
filtering effect on the data.

Figure 12.14: Time filter dialog

12.8.1 Validation
On startup, the time filter dialog validates the data files in the project. A progress bar in the
bottom left corner indicates the progress of this operation. For projects with a large number of
data files, this process may take some time to complete.

12.8.2 Preview
The time filter dialog can provide a preview that is updated in real time. This preview is
available if inspector points, discs or rectangles have been added to any of the contour plots in
the project. Note that the preview only becomes available after validation of the input files and
after a variable for filtering has been selected.
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12.8.3 Variables
In the variable box, one or more variables can be selected to which the filters are applied. The
Replace variables check box can be used to overwrite the existing variables with the filtered
results instead of creating new variables. The Add filter names to variables check box indicates
whether the variable names of the filtered data should contain a description of the filter chain or
not.

12.8.4 Filter Selection and Filter Chains
The type of filter to be applied can be selected in the drop-down box in the top-left corner of the
dialog. By clicking the Add button, a second or third filter can be added to the filter chain. The
Remove button can be used to remove an unwanted filter from the filter chain. Note that the
filters are applied in the order they are added, as indicated by the number for the filter displayed
on the tab bar.

12.8.5 Binomial Filter
The binomial filter is useful to apply moderate amounts of smoothing to the data. The binomial
filter is a simple convolution filter. For a filter size of 3, the convolution mask is 1/4[1 2 1], and
the larger filter masks can be obtained by repeated convolution of this mask with itself. The
filter options for the binomial filter are shown below.

Figure 12.15: Binomial filter options.

12.8.6 Median Filter
The median filter is useful for removing outliers from the data. The filter computes the median
value in a neighborhood with user selectable size (see figure below). If the median filter is used
in a filter chain, it should always be selected as the first filter so that outliers do not contribute
to the results of the other smoothing operations.

12.8.7 Recursive Low-Pass Filter
The recursive low-pass filter can be used to efficiently provide a large amount of smoothing. As
illustrated below, the filter provides a user-selectable cut-off frequency and order. The cut-off
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Figure 12.16: Median filter options

frequency is the (normalized) frequency at which the transfer function has a value of 50%. The
order determines the steepness of the fall-off. Note that for very low cut-off frequencies, this
filter does not preserve the mean value of the data.

Figure 12.17: Recursive low-pass filter options.

12.8.8 Spline Fit Filter
The spline fit filter can be used to provide large amounts of smoothing. Depending on the order
of the spline (linear, quadratic or cubic), this filter fits a curve consisting of multiple segments
with c0, c1 or c2-continuity between the segments. The lower the number of segments, the more
smoothing is accomplished. Note that the number of segments must be lower than the number
of data points. The options panel for the spline fit filter is shown below.

12.9 Time Averaging Data
The Time Averaging dialog is used for dealing with data which requires time averaging to
eliminate certain biases or provide extra accuracy.

This functionality is designed to work with data which has been acquired in a specific way:
for each specimen state, n image pairs should be acquired. For instance, 10 images taken at the
reference state, 10 images taken at the first load step, etc. Next, the data including all images
should be analyzed as usual. With the data below, we have taken 5 images at each of 8 load
states, including the reference state.
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Figure 12.18: Spline fit filter options.

Once the data is calculated from the speckle images, click Data. . . Postprocessing tools. . .
Time Average Data on the main menu.

Figure 12.19: Time average dialog.
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12.9.1 Options
If the First group as reference box is checked, the first set of data will be averaged to create
a new reference configuration; then, this reference configuration will be subtracted from later
groups, in effect re-referencing all of the data to a new, averaged meta-reference image.

The Group size indicates the number of images taken at each stage. Only divisors of the
data file count may be selected so it is important that the correct number of input data files are
present (an even multiple of n from above).

The new data files are prefixed with the selected Output prefix.

12.9.2 Selecting files
The available data files are displayed in the list box. To select which files to process, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files; the
Invert button inverts the selection.

To begin the computation, click the Start button.

12.9.3 Results
Once the computation is finished, a new set of averaged data files will appear in the project
panel under Other data as illustrated in Fig. 12.20. These data files contain the time averaged
(and re-referenced, if selected) data. For plotting purposes, each averaged file is linked to a single
input image so that 2D plots will display correctly.

12.9.4 Usage notes
The time average function can be used for any data that is noisy over time. Examples would
include data which has pixel noise due to low light/high gain, as well as data which is corrupted
by refractive heat waves. The specimen itself should be in exactly the same position for each
of the n images to avoid any bias; ideally, the only thing changing within an image set is the
relevant noise.

12.10 Math Operations
The Math operations dialog allows manipulation of output data by basic math operations. Open
this dialog by selecting Data... Math Operations from the main menu bar.

12.10.1 Data File Selection
The available data files are displayed in the list box. To select which files to process, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files; the
Invert button inverts the selection.
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Figure 12.20: Project data panel showing time average data.

12.10.2 Operation
Choose Add, Subtract, Multiply, or Divide to perform the specified operation.

12.10.3 Arguments
The Variable box is used to select the variable to operate on. Any variable in the data set may
be selected.

To use a constant argument, select the Constant radio button and enter the value. For
example, the selections below will multiply the u-displacement value from each data file by 10.

To use the data from an output file, click Data and select a data file. For example, the
selections below will subtract the Z shape from the first data file, from all data files.

Click Start to begin; the progress bar will indicate completion. For each strain and displace-
ment variable in the dataset, a derivative in time will be added and can be viewed as a contour
overlay.
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Figure 12.21: Math operations dialog.
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Figure 12.22: Math operation using a constant input.
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Figure 12.23: Math operation using a data file as input.



Chapter 13

Exporting Data

Calculated position and displacement data, along with transformed and post-processed variables,
can be exported via several different options:

• All data - export entire data set
• Pixel grid data - sample data set on a pixel grid
• Metric node data - place surface nodes using metric coordinates, e.g., for FE comparisons
• Aggregate statistics - export mean, median, deviation, min, max for selected files and

variables

When viewing exported data, keep in mind that X, Y, and Z are the reference position
of each point. In Vic-3D, these values are displayed as changing through time for
visualization, but in exported data, these values will be constant through time.

13.1 Exporting All Data
For efficient file access, Vic-3D stores results in a binary data file format. To use the data with
other programs for post-processing and plotting, the data can be exported by selecting the
Export item from the Data menu or using the keyboard shortcut CTRL+E. The dialog shown in
Fig. 13.1 will appear.

13.1.1 Selecting Files for Exporting
The available data files are displayed in the list box. To select which files to export, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files.

13.1.2 File Formats
The data files can be exported to the following formats:

77
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Figure 13.1: Export data dialog.
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Comma-Separated Variable
Data entries are separated by commas. This format is understood by most spreadsheet
programs and plotting packages. Variable names are stored in the data file as comma-
separated strings in quotation marks. Exported files will have the extension csv.

Tecplot
Used for plotting the data with Amtec’s (www.amtec.com) plotting program Tecplot(TM).
Exported files will have the extension dat.

Plain ASCII
This format is plain, space-delimited ASCII text data with one data point per line. Note:
There are no variable names in the data file, and data from different AOIs is concatenated.
Exported files will have the extension txt.

STL Format
This format provides a triangulated surface compatible with many CAD programs.

Matlab V4
This format provides compatibility with Matlab and many other programs capable of
reading Matlab files. Note that if multiple AOIs are present in a datafile, unique names for
each of the matrices are generated by appending increasing numbers to the variable names.
For instance, the X-coordinate for the first AOI will appear as X in the matlab file, and
for the second AOI it will appear as X_0 and so forth.

If none of the available file formats fit your needs, please contact sup-
port@correlatedsolutions.com. We will gladly implement data exporting to a format
that best suits your needs.

13.2 Exporting Grid-Based Data
This option can be used to export your data, sampled at regular intervals spatially (in the image
domain) and for each data file, to a single text file. To begin, select Export Grid Data from the
Data menu.

13.2.1 Data File Selection
The available data files are displayed in the list box. To select which files to process, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files; the
Invert button inverts the selection.

13.2.2 Options
To change the sample interval in pixels, adjust the Sample step value. A value of 1 will sample
every pixel; higher values will result in a sparser data set.

http://www.amtec.com
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Figure 13.2: Extract grid data dialog.

To export blank values to the output file, with a value of 0, check the Export blanks box. If
this box is cleared, blank data points will not be present in the output file.

13.2.3 Extracting Data
To begin, click Start. You will be prompted for an output .csv file name. A progress bar will
appear; when extraction is complete, the dialog will close.

13.3 Extracting Node Data
This option can be used to export spatially sampled data to one or more CSV files.

13.3.1 Adding Sample Points
Exported data is sampled based on X, Y coordinates. You can add a single point at a time, or a
line, circle, or grid, by clicking on the appropriate button. This can be repeated as many times
as desired to add as many points as necessary. Points on the surface will be displayed as green
markers; points which do not fall on the surface for a given data file are shown as red.

To save a set of points for future use, click the disk icon next to the file dropdown. To restore
from an existing file, use the file dropdown, or select Add File.



13.3. EXTRACTING NODE DATA 81

Figure 13.3: Extract node data dialog.

13.3.2 Data Files

Use this list to select one or more data files to extract from.

13.3.3 Variables

Select the desired output variables from this list.

13.3.4 Use deformed coordinates

To overlay the selected X, Y points on the deformed shape, check this box. To overlay the
coordinates on the initial shape (while still exporting deformation data), clear the box.
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Figure 13.4: Points sampled along a line.

13.3.5 Preview and Export
Click Preview to see the position of your points on the selected file. To export the data
according to your selected points, click Export.

13.3.6 Export Options
After clicking the Export button, a dialog with options will appear as illustrated below.

Separate files w/prefix
This option writes a separate file for each data file. A prefix that is prepended to the data
file name can be specified in the text input field.

Single file
This option writes all data in a single file. There are two choices for the arrangement of
the data:

• Data in columns: Each data point is in a separate column, i.e., the rows can be
thought of as the time axis. For this data arrangements, the analog data from the
project can be added as additional columns.

• Data in rows: Each data point is written to a separate row and consecutive data
files are separated by the number of blank lines specified in the spin box.
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Figure 13.5: Export options dialog.

Add data headers
This option writes headers with the variable names.

Skip invalid points
This allows to suppress output of sample points where no data is present.

Flag invalid points
This option adds a valid_flag to each data point, indicating whether data is present (1)
or not (0).

13.4 Calculating Statistics
To export statistics for calculated variables and data files, select Data. . . Statistics from the
main menu bar.

13.4.1 Statistics
Check the desired item to include or exclude the statistic from the output file.

13.4.2 Variables
Check the desired variables to add them to the calculation. By default, all metric variables are
included, while correlation and pixel variables are excluded.
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Figure 13.6: Statistics dialog.
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13.4.3 Data File Selection
The available data files are displayed in the list box. To select which files to process, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files; the
Invert button inverts the selection.

13.4.4 Exporting
To complete the calculation, click Ok. You will be prompted for a filename, and the data will be
exported as a .CSV file.

13.5 Calculating Statistics
To export statistics for calculated variables and data files, select Data... Statistics from the main
menu bar.

13.5.1 Statistics
Check the desired item to include or exclude the statistic from the output file.

13.5.2 Variables
Check the desired variables to add them to the calculation. By default, all metric variables are
included, while correlation and pixel variables are excluded.

13.5.3 Data File Selection
The available data files are displayed in the list box. To select which files to process, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files; the
Invert button inverts the selection.

13.5.4 Exporting
To complete the calculation, click Ok. You will be prompted for a filename, and the data will be
exported as a .CSV file.
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Figure 13.7: Statistics dialog.



Chapter 14

Plots

A plot of the data can be displayed by double-clicking on a data file in the list view to the left of
the workspace. A plot will be displayed in the workspace as shown below.

14.1 Plot Options
Plot options can be accessed by right-clicking in the plot window.

The Contour variable submenu can be used to select the variable to display.
The Show min. value and Show max. value options will flag the minimum and maximum

valued data points.
By default, data is displayed in the deformed location on the deformed image. To show the

reference position for the data, click Show reference data.
Click Change legend orientation to toggle between a horizontal and vertical legend.
Click Statistics to view a summary of data for the current image, for the currently selected

contour variable.
Copy copies the current plot to the clipboard; Save allows saving the plot as an image file.
Select Export video to save an animated video.
Click Detach to keep this plot static instead of updating it each time a new data file is clicked

in the Data tab.

14.2 Editing Plot Parameters
To edit other plot parameters, use the plot toolbar.

14.3 Inspector Tools
Tools for probing and extracting data are located in the Inspector Toolbar, and can also be
selected by clicking Plot... Inspector in the main menu bar.

From left to right, the tools are:

• Pan/Select: Pans around the contour image, when zoomed in; selects existing extract
points. To select an item, click on the small square handle.

87
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Figure 14.1: 2D contour plot display.
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Figure 14.2: 2D plot context menu.

Figure 14.3: Inspector tools
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• Inspect point: select this tool and click to probe at a single point. The value for the
currently selected contour variable, at the chosen point, will be displayed.

• Inspect line: select this tool and click once to start a line; click again to finish. The value
will be displayed at each node.

• Inspect polyline: select this tool and click to create line nodes; double-click to finish. The
value will be displayed at each node.

• Inspect circle: select this tool and click to define a center; click again to define a disc. The
value at the center will be displayed.

• Inspect rectangle: select this tool and click to define a center; click again to define a
rectangle. The value at the center will be displayed.

• Extensometer: select this tool and click two points; this tool shows the extension (change
in length divided by initial length) between the two points.

• Delete: choose this tool and click on an existing point/line/area to remove it.
• Extract: click to open the Extraction dialog.

Once a tool is selected, you can place it on the plot by clicking.

• For the point tool, click once to place the point.
• For the circle, rectangle, and line tools, you can click once to place the first point, and

again to define the shape.

Once a tool is placed, you can use the Pan/Select tool to move the inspector or to adjust the
control points.

14.4 Animating Plots
To animate contour plots, bring up the plot display and then use the controls on the Animation
Toolbar to animate the sequence.

14.5 Saving the Plot
The displayed plot can be saved as a BMP, PNG, or JPG image file by selecting Save from the
context menu. To copy the plot to the clipboard, select Copy.

14.6 The Plot Toolbar
The plot toolbar is displayed at the top left edge of the work area by default. It contains options
and controls for contour plots.

14.6.1 Auto-Scaling
This tab controls auto-scaling. Check or clear the boxes to enable auto-rescaling of contour
overlay limits. Check Grow ranges only to allow ranges to get larger but not smaller. With
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Figure 14.4: Auto-scaling tab.

this box checked, you can animate through all images to set the limits to the minimum and
maximum over all data files. This is useful for producing consistent animations and videos.

14.6.2 Contour

Figure 14.5: Contour tab.

This tab allows control of the contour overlay of 2D plots. To automatically scale these values
to fit the data, check the Auto-rescale contour box. To manually set the limits, clear this box
and enter the desired values.
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Use the strain unit control to determine how strain values are displayed; the default is unity,
i.e., mm/mm.

14.6.3 Color

Figure 14.6: Color tab.

Use this tab to control the display of contour overlays. The Color map box chooses the
overall color set for the plot. The Opacity box sets the opacity of the overlay; this option affects
2D plots only. The Levels box sets the n box sets the number of discrete contour levels. The
Level labels box controls the number of numeric level indicators.

14.6.4 Iso-lines

Use this tab to display iso-lines on the contour plot.
If many levels are present, you can increase the Level skip to reduce clutter. The thickness of

the isolines and the color can also be adjusted.

14.6.5 Vector

This tab controls display of strain and displacement vectors.
Skip and scale control the size and density of the vectors. The use solid color checkbox

causes the vectors to be displayed in a single color rather than the underlying plot color; the
color selector button can be used to choose this color.
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Figure 14.7: Iso-lines tab.

Figure 14.8: Vector tab.

14.6.6 Legend
These controls affect the format of the contour legend. Select a Format from Number, Scientific
(exponential notation), or Best (most concise method). Select a number of Digits, or Automatic
to use as much precision as necessary.

14.7 Exporting Videos
To export an animation from a 2D plot, right-click in the plot and select Export Video.

If the auto-rescaling feature is enabled for contours or axes, you will see a warning:
When rescaling is on, the animation may not appear as expected because each frame will be

scaled differently. Click Yes to continue or Cancel to correct the condition. When complete,
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Figure 14.9: Legend tab.

Figure 14.10: Warning message when auto rescaling enabled.

the following dialog appears:

14.7.1 File

Click the icon to select a filename for saving.

14.7.2 Encoder

• To use the built-in codecs, select AVI.
• To use a choice of external codecs with a supported external encoder, select External

converter.
• Select Image Sequence to export a sequence of numbered individual images rather than a

video.
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Figure 14.11: Video export dialog

14.7.3 Format
Select from available compression formats; options will vary based on system configuration and
installed codecs.

For videos which will be recompressed, select RGB Uncompressed to make a very large but
lossless video.

14.7.4 Data File Selection
The available data files are displayed in the list box. To select which files to process, click on the
data file you want to select/deselect. This will toggle the check mark indicating whether the file
is selected or not. For convenience, the buttons labeled All and None select/deselect all files; the
Invert button inverts the selection.

To begin, click Export; a progress bar will indicate completion.

14.8 Extraction Plots
Extraction plots can be generated for the dataset as a whole, or for lines, points, and areas
by using the Inspector Tools in a 2D plot. An extraction data plot as illustrated in Fig. 14.12

will be shown when the Extract button ( ) is pushed while viewing a 2D Plot. Note that an
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extraction plot can be generated even if no inspector items are present. In this case, only the
average values will be available for plotting. Depending on the types of inspector items that
have been added to the contour plot, different plot types will be available:

• Points (default) for average, points, area averages.
• Line slices for lines and polylines.
• Extensometers.
• Points and Extensometers.

Figure 14.12: Extraction plot.

A long press on the ( ) button will allow selection of Complex plot extraction

14.8.1 Selecting X/Y Data for Plotting
Each X/Y data pair shown in the plot will be listed in the Extraction tools tool box (see Fig. 14.13)
and shown in the plot’s legend (if configured, see Section 14.8.8). The X/Y data that is shown
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in the plot can be edited in the tool box.

Figure 14.13: Extraction plot tool box.

To select the variables for a new or an existing X/Y pair, the X/Y data source and variable
can be selected from the drop-down menus below the list box. Available data sources are:

• Average corresponds to the average value from the entire data set.
• P0, R0, C0, etc. are the values corresponding to inspector tools (points, rectangles, circles

etc).
• Analog data corresponds to CSV data added to the project. This is normally a file generated

by Vic-Snap.

After the variables for X or Y have been selected from the menus, the apply button on the
right must be pressed to apply the changes. Note that the change applies to all X/Y pairs
selected in the list box.

To delete an X/Y pair, the item must first be selected in the list box, followed by pressing
the Delete button.

New X/Y data pairs can be added to the plot by first selecting the New item in the list box
at the top. Then, the data source and variables can be selected from the drop-down menus and
the new X/Y pair is finally created by clicking the Add button.

To export plot data, the Export button can be pressed to bring up the Export data wizard.

14.8.2 The Extractions Menu
Only present in Vic-3D 9 the extractions menu allows for deleting of extractions as well as
re-opening past extractions.
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The main purpose of this workspace is to open past extractions to manipulate the data for
use in the iris workspace.

Figure 14.14: Extractions menu.

14.8.3 Navigating in the Plot
Use the mouse wheel to zoom in or out on the plot. Click and drag to pan; double click to fit
the plot to the window.

To adjust a single axis scale, mouse over that axis; the cursor will change to indicate the axis
is active. Then, use the mouse wheel to zoom only that axis.

To zoom to a selected box, hold the shift key and drag to indicate the zoom area.

14.8.4 The Context Menu
Right-click in the plot to access options.

• Cursor: select from axis indicators for X, Y, or both axes; select Snap Cursor to display
the value reading closest to the cursor.

• Copy: copies the plot to the clipboard.
• Save: select to save the plot as a graphics file.
• X/Y axis scale: submenus allow changing between linear and logarithmic axis scaling.
• Settings: click to access the plot settings.
• Quick help: display a brief overview of the plot navigation controls.

14.8.5 Point Extractions
By default, extraction plots are shown in Point mode, which displays the average data as well
as data generated by inspector items of type point and those that average over an area (discs,
rectangles etc.). The plot type can be selected from the drop-down menu at the top of the
extraction tool box, see Fig. 14.13.



14.8. EXTRACTION PLOTS 99

14.8.6 Line Slice Extraction and Plotting
Line slices may be plotted only when an extraction line or polyline is present. They can be
created using the Inspector Tools to add lines ore polylines to a 2D contour plot. An example of
a line slice inspector item is illustrated in Fig. 14.15.

Figure 14.15: Line slice in contour plot.

After clicking the Extract button ( ) an extraction plot will appear in the workspace,
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but will initially show the available Point extractions. To display the line extraction, the entry
Line slices must be selected from the pull-down menu in the extraction tool box as illustrated in
Fig. 14.16.

Figure 14.16: Extraction tool box for lines slices.

On the plot, a series of lines will be shown that shows the extracted data at different times.
The line for the currently selected data file will be highlighted, as illustrated in Fig. 14.17. The
number of lines that are shown in the plot can be configured in plot settings, see Section 14.8.8.

14.8.7 Extensometer Extraction and Plotting
Extensometer plotting will be available when one or more extensometers have been created using
the Inspector Tools in a 2D plot view as illustrated in Fig. 14.18.

Clicking the Extract button ( ) brings up the plot window. To switch the display to
extensometers, the entry Extensometers must be selected from the pull-down menu at the top
of the extraction tool box as illustrated in Fig. 14.19. If both points and extensometers are
present, the entry Points and extensometers will also be available to show extensometer and
point extraction data in a single plot.

14.8.7.1 Extensometer Variables

The extensometer plot can be used to show a number of variables that are available for each
extensometer extraction, including the relative change in length as illustrated in Fig. 14.20.

The available extensometer variables are:
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Figure 14.17: Line slice plot.

• ∆L/L0: The change in length divided by the initial length; unitless.
• ∆L: The change in length, in display units.
• L1: The deformed length, in display units.
• L0: The initial length, in display units.

The strain displayed here will not necessarily match the strain computed in the Strain
dialog, depending on the tensor you have selected. The extensometer strain is a simple
length calculation and does not account for bending, etc.

14.8.8 Plot Settings
The plot settings can be accessed from the context menu of the plot (see Section 14.8.4). This
displays a dialog with different options to control the plots as illustrated in Fig. 14.21.

The first tab controls graph display settings.

• Graph style: select from lines, points, or both. If Points is selected, you can use the snap
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Figure 14.18: Extensometer in contour plot.
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Figure 14.19: Extraction plot tool box for extensometers.

cursor to evaluate values at specific locations in the plot. With Lines selected, the snap
cursor will give an interpolated value.

• Show legend: click to show or hide the legend.
• Legend position: select the location of the displayed legend on the plot.
• Theme: choose from a white background scheme (“Daytime”) or a black background

scheme (“Midnight”).

The second tab applies to time extraction only. You can select whether to highlight the
currently displayed data file; and select which data files to plot. All are plotted by default.

The third tab applies to line slice extractions only.
Under Mode, you can choose to display lines for the current file and the select files; only the

current file; or only the selected files (select files from the list below). You can also adjust the
style of the non-selected lines as well as the color for them.

Select the files to be extracted from the list at the bottom.
By default, 200 points are created along the extracted line. Since the line does not necessarily

pass through exact data points, data points are interpolated at equidistant intervals along the
line. The number of sample points can be changed by pressing the Change button. This will
display an spin box control where the desired number of points can be selected. Note that
changing the number of points results in the data being extracted again. The progress of this
operation is indicated in a progress bar at the bottom of the plot window.

14.8.9 Exporting Slice Data
To export data, click Export in the extraction tool box. The Export Data Wizard will appear.
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Figure 14.20: Extensometer extraction plot.

• Output file: click the folder icon to choose an output file.
• Data type: choose from line slice or time extraction.
• Format: select from comma separated (typical for use with Excel) or tab separated.
• Ordering: select row index to have a row for each file (most common), or column index to

have a column for each file (useful for making waterfall type plots).
• Coordinates: if you select reference coordinates, the XYZ values will not change over time.

Select deformed coordinates to add UVW deformation to the XYZ values, making them
change with time.

14.9 Complex plot extractions

Holding the button will allow selection of Complex plot extractions via a dialog box.
While the simple extraction is limited to average values, complex extractions allow selection

of statistical functions (minimum, maximum, mean, median, standard deviation) with the
Statistics group.

The Data Files group allows selecting a subset of data.
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Figure 14.21: Plot settings style tab.

Extracting a limited number of data files can improve extraction speed when accessing
a slow or networked drive.

14.9.1 Rotation angles
Rotation angles may be calculated by checking Add rotation angles. This computes rigid-
body transformation (rotation) angles for area-type inspector items (discs, rectangles etc.). The
transformation matrix can be computed from the pitch, yaw and roll angles α, β and γ as follows:

R =
 cos(β) cos(γ) sin(α) sin(β) cos(γ)− cos(α) sin(γ) cos(α) sin(β) cos(γ) + sin(α) sin(γ)

cos(β) sin(γ) sin(α) sin(β) sin(γ) + cos(α) cos(γ) cos(α) sin(β) sin(γ)− sin(α) cos(γ)
− sin(β) sin(α) cos(β) cos(α) cos(β)


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Figure 14.22: Plot settings time slice tab.

The translation component of the rigid body transformation can be computed from the location
of the area’s centroid X0, Y0, Z0 and the average displacement as follows:

T =


Ū
V̄
W̄

+


X0
Y0
Z0

−R


X0
Y0
Z0


Note that the transformation given by R and T transforms reference coordinates into the
deformed state.

Check Add deformation to shape to add the variables Xd, Yd and Zd to the data set.
These are the deformed values (X+U ), (Y+V ) and (Z+W ).
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Figure 14.23: Plot settings line slice tab.
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Figure 14.24: Extraction plot export wizard.
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Figure 14.25: Complex extraction settings.





Chapter 15

Quick Start

There are only a few steps involved in obtaining shape and deformation measurements from your
images. If you are using Vic-2D for the first time, take a look at the example provided with the
program. Then, try to go through the following steps yourself to quickly familiarize yourself
with the program usage:

1. Add a reference image and select your area of interest.

2. Add more speckle images, if applicable.

3. Run the correlation analysis.
4. Plot the results

If you encounter any difficulties, please do not hesitate to contact our technical support
department.

15.1 What’s New in Vic-2D 6

Completely new tools for drawing AOI’s and setting up initial guesses.
Improved parallelization for taking even better advantage of multi-core processors.
New equation editor with user-selectable constants.
Strain calculation is now quicker and more accurate.
User interface redesigned for increased ease of use.
Inspector tools have been completely redone. They are saved to the project, nodes can be

moved and there is undo/redo functionality.
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Plots for extractions (points, lines, circles, rectangles and extensometers) have been replaced
by a new plot widget
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• It is possible to plot multiple line slices (waterfall plot)

• Multiple time extractions can be plotted together.

• Multiple variables can be plotted on individual lines.

• The plots have different cursors (snap, x/y, x and y cursor) for precise examination of
data.

• There is a new data export wizard with improved formatting options.

• The average values for each data file are now automatically extracted even when no
inspectors are present.

When the project is saved, the plot settings for all open contour plots are saved.
Reopening the project will automatically bring up your previous arrangement of plots and

inspector tools.
When projects are saved, Vic-2D generates a set of preview icons that are stored in the

project.
There is a new start screen that displays recent projects using the preview icons.
A longer list of recent projects is now available under File->Open recent...
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There is a new post-processing option, "Time filter data", with comprehensive tools for
smoothing data.

Performance when loading large projects has been improved.
Results can now be viewed in user-selectable units - inches, microns, etc.



Chapter 16

Technical Support

If you cannot find an answer to your question in this manual, please do not hesitate to contact
our technical support at support@correlatedsolutions.com. You can also find contact information
at our web site at www.correlatedsolutions.com.

We will be happy to assist with topics such as:

• Designing digital image correlation experiments
• Calibration
• Troubleshooting errors
• Interpreting test data
• Achieving optimal results

16.1 Bug Reports and Feature Requests
If you encounter a bug in Vic-2D, please let us know about it. Send a short description of the
problem to support@correlatedsolutions.com, along with any project or image files you think
may help us reproduce the bug.

Also, if you think Vic-2D can be improved by adding a particular feature you would find
helpful, let us know about it. We will try to incorporate your requests in our future updates of
the software.
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